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Chapter 1 : Differences between using a document in the browser and in Word - Word
The layouts of my documents are often different on the different computers. I haven't noticed this issue when documents
just contain paragraphs of text, but most of the documents I use involve lots of page breaks and tabs, and this is where
the main issue is.

In this view the current page takes up the full width of the window, and is displayed how it would appear on a
printed page. If a document that you have opened looks different, then the view mode was changed by the last
person that edited the document. A view change occurs when a document is saved in that view mode. If the
document that you want to change was created by someone else, then it is likely that the document was in that
view when they saved the file. Fortunately you can select a different view for your current document by
following a few short steps. Changing the View in Word The steps in this article will show you how to find
the selection of views in Microsoft Word If you are seeing a different view, then it is associated with the
document that you are viewing. Follow the steps below to change the view, then save the document so that it
opens in your preferred view the next time you open it. If the steps below are not working for you because you
are not seeing the different view options described in Step 3, then your document is probably in Read Mode.
You can press the Esc key on your keyboard to exit this mode, then you can follow the steps below. Open
your document in Word Click the View tab at the top of the window. Select the view that you would like to
use from the options in the Views section at the left side of the navigational ribbon. As mentioned before, the
Print Layout option is the default view. Be sure to save the document after changing the view if you would
like it to open with this view the next time you open the document. Note that there is an issue with documents
that are saved in Outline or Draft view. These documents will still open in Print Layout, even if saved in those
views. These steps will only change the view for the current document. It will not change the default view for
new documents that you open in Word Additionally, other documents that you receive from other people may
still open in a different view mode due to how the file was saved by the last person that edited it. Are you
having a similar issue in Microsoft Excel ? This article will show you how to return to Normal view in that
program.
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Chapter 2 : Avoid Layout Changes on Different Computers : MS Word
Different printer, different look. Word processors like Word are generally designed to produce documents to be printed.
When Word displays a document in a print layout or page view, it uses the characteristics of the currently-selected
printer to determine what the document will look like when printed.

In you operating system search for the normal. Start Word, and then open the document. Change the document
template Open the problem document in Word. In Word, click File on the Ribbon, and then click Options. In
the Manage box, click Templates, and then click Go. In the Templates folder, click Normal. Click OK to close
the Templates and Add-ins dialog box. Verify that changing templates worked. Click the damaged document,
and then click Open. If the strange behavior persists, go to method 2. Additionally, Word does not use your
existing Normal. In your operating system search for Run. In the Run dialog box type in winword. If the
strange behavior persists, go to method 3. Change printer drivers Step 1: Try a different printer driver Step a:
Click Add a printer. Add a new printer In the Add Printer dialog box, click Add a local printer. Click Use an
existing port, and then click Next. In the Manufacturer list, click Microsoft. Click Use the driver that is
currently installed recommended , and then click Next. Click to select the Set as the default printer check box,
and then click Next. Verify that changing printer drivers fixes the problem Start Word. In Word, click File on
the Ribbon, and then click Open. If the strange behavior persists, go to step 3. Reinstall original printer driver.
Right-click the original default printer, and then click Delete. If you are prompted for an administrator
password or for a confirmation, type the password, or click Continue. If you are prompted to remove all the
files that are associated with the printer, click Yes. Click Add a printer, and then follow the instructions in the
Add Printer Wizard to reinstall the printer driver. If the strange behavior persists, go to method 4. Force Word
to try to repair a file Step 1: In the Open dialog box, click to highlight your Word document. Click the arrow
on the Open button, and then click Open and Repair. Verify that repairing the document fixes the problem
Verify that the strange behavior no longer occurs. If the strange behavior persists, restart Windows, and then
go to method 6. Change the document format, and then convert the document back to the Word format Step 1:
Open the document Start Word. Save the document in a different file format In Word, click File on the
Ribbon, and then click Save as. In Word, click Other Formats. In Word, click File on the Ribbon, and then
click Close. Open the document, and then convert document back to Word file format In Word, click File on
the Ribbon, and then click Open. Click the converted document, and then click Open. In Word, click File on
the Ribbon, and then click Save as. Choose Word Document for the Save As type. Verify that converting the
document file format fixes the problem Verify that the strange behavior no longer occurs. If the behavior
persists, try to save the file in another file format. Repeat step 1 to step 4, and then try to save the file in the
following file formats, in the following order: However, all document formatting, macro code, and graphics
are lost. When you save files in the Plain Text. Therefore, use the Plain Text. If the strange behavior persists,
go to method 7. Copy everything except the last paragraph mark to a new document Step 1: Click Blank
document, and then click Create. Open the damaged document Start Word. Copy the contents of document,
and then paste the contents into the new document Note If your document contains section breaks, copy only
the text between the sections breaks. Do not copy the section breaks because this may bring the damage into
your new document. Change the document view to draft view when you copy and paste between documents to
avoid transferring section breaks. To change to draft view, on the View tab, click Draft in the Document
Views group. On the Home tab, click Copy in the Clipboard group. On the View tab, click Switch Windows in
the Window group. Click the new document that you created in step 1. On the Home tab, click Paste in the
Clipboard group. If the strange behavior persists, go to method 8. Copy the undamaged parts of the damaged
document to a new document Step 1: Copy the undamaged parts of document, and then paste the undamaged
parts to the new document Note If your document contains section breaks, copy only the text between the
sections breaks. Repeat steps 3a to 3e for each undamaged part of the document. You must reconstruct the
damaged sections of your document. Switch the document view to remove the damaged content If the
document appears to be truncated not all pages in the document are displayed , it might be possible to switch
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the document view and remove the damaged content from the document. Determine the page number on
which the damaged content is causing the document to appear to be truncated. Scroll to view the last page that
is displayed before the document appears to be truncated. Note the content that appears on that page. Switch
views, and then remove the damaged content. Scroll to view the content that was displayed before the
document appeared to be truncated. Select and delete the next paragraph, table, or object in the file. If the
document continues to appear to be truncated, continue to switch views and delete content until the document
no longer appears truncated in Print Layout view. Troubleshooting steps to try if the damaged document does
not open Method 1: Open the damaged document in draft mode without updating links Step 1: In Word, click
the File Menu, and then click Open. If you can open the document, close the document and then reopen it by
using method 6, and repair the document. Otherwise go to method 2. Insert the document as a file in a new
document Step 1: Note You may have to reapply some formatting to the last section of the new document. In
the Insert File dialog box, locate and then click the damaged document. Create a link to the damaged
document Step 1: In the new document, type This is a test. In Word, click the File Menu, and then click Save.
Type Rescue link, and then click Save. Create link Select the text you typed in step 1c. In Word, click the File
Menu, and then click New. On the Home tab, click the arrow on the Paste button in the Clipboard group, and
then click Paste Special. Change the link to the damaged document Right-click the linked text in the
document, point to Linked Document Object, and then click Links. In the Links dialog box, click the file name
of the linked document, and then click Change Source. In the Change Source dialog box, click the document
that you cannot open, and then click Open. Click OK to close the Links dialog box. Note The information
from the damaged document will appear if there was any recoverable data or text. Right-click the linked text,
point to Linked Document Object, and then click Links. In the Links dialog box, click Break Link. When you
receive the following message, click Yes:
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Chapter 3 : Why does my document layout change on different computers? - Microsoft Community
Many users like to work at home, but opening a Word document on another system can play havoc with a document's
layoutâ€”I spent a lot of time formatting this document, but when I opened it at.

One of the things he suggested to make online writing groups run smoothly was to use Dropbox to prevent the
headaches of emailing and keeping track of different versions of a file commented on by the group members.
Is this the best way to keep a common copy of a document with multiple commenters? This week Evan and I
set out to test out what would happen if we used Word and Dropbox with both of us commenting on the same
document, as well as us both commenting on a shared document in Google Drive. Here is what my test shared
Dropbox folder looks like. This means that with a shared folder, all members of that folder have all the same,
synced files in that folder. So if someone else makes a change to that file and saves it, those changes will be
updated on that file on my computer. For more information on Dropbox, see my previous post. MS Word and
Dropbox This worked well enough. This means that if you want to have multiple people commenting on a
shared draft in Dropbox it will work. However, it might cause problems if more than one person edits the
document at the exact same time. Using Dropbox to do this only sort-of worked. The good news is that the
comment he made was still labeled with his name and the time, and highlighted the proper text. The big
downside to this method â€” and the reason I am not enthusiastic about it â€” is that two people cannot work
on the shared document at the same time. Google Drive is on the right and the Word version of those
comments is on the left. You can create several different types of files, including text documents,
spreadsheets, forms, and presentations. You can also import documents that are in Word format. You can
easily share any document that you are working on, so if you have a writing group, you could share a version
with the members of your group and they will each get an email letting them know. The commenting feature
on Google Drive is great â€” you can comment on stuff and reply to the comments easily. When I downloaded
the commented-on file back to my hard drive as a Word document , I found that the comments were in there,
as well as the identifying information and reply information, i. One of features that I really liked about using
Google Drive was that after Evan and I made comments on my document, I was surprised to get an automated
email letting me know that he had made changes to my document, and the email also contained a summary of
the changes. If I were using it for a writing group, it would let me know that someone had made comments, so
I could go and check them out. The comments were preserved, but the identifying information about them was
lost. Curious, I exported that document back into Word. Using Scrivener would work in a pinch, but I would
recommend that you ask people to sign their comments if you do it this way. If I were in a writing group, I
would definitely use Google Drive. I also appreciate that with Google Drive, the important information about
comments i.
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Chapter 4 : News, Tips, and Advice for Technology Professionals - TechRepublic
To open a PDF file without converting it to a Word document, open the file directly wherever it's stored (for example,
double-click the PDF file in your Documents folder). However, if you want to edit the PDF file, go ahead and open it in
Word. Word makes a copy of the PDF, converting it to a Word.

Symptoms When you view your document in Microsoft Word, some characters may be missing, or the top or
bottom of some characters may be cut off. This problem may affect the following types of characters:
Underscore Character with a descender International character that contains an umlaut, acute accent, grave
accent, circumflex, or tilde Object that is inline with the text of your document--for example, a picture that is
not inserted in a frame or text box NOTE: This problem does not affect printing; that is, underscores,
characters with ascenders or descenders, and international characters are printed correctly although they may
not be displayed correctly. Cause This problem may be caused by one of the following. Case 1 The line
spacing of your text may be set to an exact height. When you set the line spacing to Exactly and select a
measurement that is equal to or less than the height of the font, underscore characters may not be displayed
and characters that have an ascender, descender, or an umlaut may be cut off. For example, if you set line
spacing to Exactly 9-point for a point font, underscore characters may be cut off. This problem may occur
differently with different fonts. Case 2 The printer driver may incorrectly substitute screen fonts at certain
view percentages. If you change the printer driver, you may notice an immediate difference, depending on the
view you are using. Case 3 The zoom percentage that the document is set to may cause characters to have the
top or bottom portion of the screen font cut off. You can adjust the zoom percentage from 75 percent to
percent in most cases to correct this visually. Resolution This problem is a display-only problem. Use one or
more of the following methods appropriate for your situation. Change the Document Zoom Setting When you
change the zoom percentage, Word may allow you to view the full height of your text. To do this, use one of
the following methods depending on the version of Word you are using: Do one of the following: Under Zoom
to, change to a larger setting. Under Percent, change the percentage to a larger setting. Under Zoom to, change
the value to a larger setting. Under Percent, change the percentage value to a larger setting. Change the
Document View When you change the view of your document to outline view, Word shows the full height of
your text. To change the view of your document in Word , in Word , or in Word , click Outline on the View
menu. To change the view of your document in Word , click Outline in the Document Views group on the
View tab. This problem may occur in normal, print layout, and Web layout views. When you view your
document in outline view, paragraph formatting is ignored. Do one or both of the following: On the Indents
and Spacing tab, change the Line spacing box to something other than Exactly. For example, change the Line
spacing setting to Single. Change the At setting to a setting slightly larger than the font point size you are
using in your document. For example, if your font point size is 10 point, then change the At setting to 11
point. Word On the Hometab, click the Paragraph dialog box launcher in the Paragraph group. On the Indents
and Spacing tab, change the setting in the Line spacing box to a setting other than Exactly. For example,
change the setting in the Line spacing box to Single. Change the At setting to a setting slightly larger than the
font point size that you are using in your document. For example, if your font point size is 10 point, then
change the At setting to On the Font tab, do one or both of the following: Change the Font setting to a
different font. Change the Size setting to a smaller size than what you have your line spacing set to. For
example, if you have your line spacing set to Exactly 12 point, change the font size to 11 point. Word On click
the Hometab, click the Font dialog box launcher in the Font group. More Information Line spacing determines
the amount of vertical space between lines of text. Word uses single line spacing by default. The line spacing
that you select affects all lines of text in the selected paragraph or the paragraph that contains the insertion
point. The following table describes the line spacing options: This option Results in Single Line spacing for
each line that accommodates the largest font in that line, plus a small amount of extra space. The amount of
extra space varies depending on the font used. For example, if point text is spaced at 1. Double Line spacing
for each line that is twice that of single line spacing. For example, in double-spaced lines of point text, the line

Page 5

DOWNLOAD PDF WHY DOES MY WORD UMENT LOOK DIFFERENT IN
spacing is approximately 20 points. At Least Minimum line spacing that Word can adjust to accommodate
larger font sizes or graphics that otherwise do not fit within the specified spacing. Exactly Fixed line spacing
that Word does not adjust. This option makes all lines evenly spaced. Multiple Line spacing that is increased
or decreased by a percentage that you specify. For example, setting line spacing to a multiple of 1. Setting the
line spacing at a multiple of 2 is equivalent to setting the line spacing at Double. In the At box, type or select
the line spacing you want. The default is three lines. At The amount of line spacing you select. If a line
contains a large text character, graphic, or formula, Word increases the spacing for that line. To space all lines
evenly, click Exactly in the Line spacing box, and then select the line spacing in the At box that is large
enough to fit the largest character or graphic in the line. If characters or graphics still appear cut off, select a
larger number in the At box. For more information, click the following article number to view the article in the
Microsoft Knowledge Base:
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Chapter 5 : 6 Ways to Use Document Templates in Microsoft Word - wikiHow
The Problem: I created my report at home and formatted it to look great, with the graphics and page breaks in just the
right places. But when I opened it at work, the layout had changed.

The problem Has this ever happened to you? Imagine your Word document contains the following sentence:
This is my interesting text. You then place your text cursor the vertical blinking line or "insertion point" right
before the word "interesting" and type "wonderful" Your intention is to insert this word. This is my wonderful
interesting text. However, in this crazy-making situation, you get this instead: This is my wonderful ng text.
The 9-character word "wonderful" has replaced the first 9 characters of "interesting," leaving you with
"wonderfulng" which is probably not what you wanted. Insert mode good vs. Overtype mode bad If you are
experiencing this odd behavior in Microsoft Word, this means that you have accidentally switched from
"Insert mode" the default to "Overtype mode. For example, you could construct a crude table using spaces to
perfectly line up the columns, and later you might use Overtype mode to "type over" parts of that table to
update it without inserting or shifting any text to the right. Modern computers and word processors typically
use proportional-spaced fonts, where narrow letters use less space than wider ones. Monospaced font Courier,
different letters all have the same width: Here are ways you can turn off Overtype mode: Quick fix 1 in
Microsoft Word for Windows any version: Tap the "insert" key on the keyboard How it can happen: If you
have a full-size Windows keyboard, tapping the "Insert" key once toggles between Insert mode and Overtype
mode. How to fix it: Type a few characters at the start of an existing paragraph to be sure. Depending on your
keyboard, you may also have to hold down a "modifier" key like "FN" or "Mode" first. Quick fix 2 in
Microsoft Word Windows or Macintosh, any version: Close and reopen First, you may want to use the Undo
command if available to restore your text to what it was before you started overtyping. Then, close all Word
documents saving your changes as appropriate , close the Word program itself, then reopen your document.
That will get you out of Overtype mode and back to Insert mode. Quick fix 3 in Microsoft Word for Windows
any version: Quick fix 4 in Microsoft Word for Macintosh: Quick fix 5 in Microsoft Word for Macintosh any
version: Additional things you should know about Overtype mode Here are some subtle things about Overtype
mode: When Overtype mode becomes active in one open Word document window, it immediately becomes
active in every other open Word window as well. Similarly, turning Overtype mode off in any open Word
window will also turn it off in all open Word windows. Closing and reopening will only turn Overtype mode
off if you close the program and thus every open Word window before reopening. Overtyping does not replace
text beyond the end of a paragraph, and does not remove paragraph breaks or section breaks, so your potential
"damage" is limited. However, it does remove line breaks, page breaks, and column breaks. If Overtype mode
was active when you saved changes to your document, that fact is not stored in the document. So, if Overtype
mode is turned off in a later editing session, reopening that document will not turn it back on. Copy and Paste
always inserts text, even if Overtype mode is on. AutoText always inserts as well. Take a screwdriver and
gently pry the "Insert" key off your keyboard; on a Windows laptop look for the "INS" key. Instead, attach it
to the side of your keyboard with scotch tape in case you need it again in the future. If you have a laptop, make
sure you can still close the lid without damaging your screen. Customize Word to remove the "Insert" key as
the shortcut for Overtype mode: On the left under "Categories," scroll down and click "All Commands. This
should disable the "Insert" key. Where to go from here Find your version of Word common versions on
Windows are , , , and ; on Macintosh are , , and , then google this replace "20xx" with your version: Word
20xx turn off overtype mode Save your important documents as you work and make backup copies of them.
You never know when something might go wrong, like Overtype mode.
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Chapter 6 : Word documents open as small windows, not full screen - Super User
New documents that you create in Microsoft Word will use the Print Layout view by default, unless you have modified
the Normal calendrierdelascience.com this view the current page takes up the full width of the window, and is displayed
how it would appear on a printed page.

Created on February 12, Why does my document layout change on different computers? Why does my
document layout change on different computers and how can I stop it? I use computers in two different
locations regularly. They both use Word , though my documents are saved as Word The layouts of my
documents are often different on the different computers. The two main problems I notice are: I begin to type
aligned with the left margin and then tab across twice and type again to get the specific layout I need. I enter a
long list. Then I repeat the process for a new list with heading. When I then open this on the other computer, I
sometimes but not always find that the text I tabbed across to type has moved, as though I only tabbed once
rather than twice. This means that it no longer aligns with the list below and is also too close to the text before
it. When my lists go onto a new page, I need to repeat the heading. So I enter a page break before the repeated
heading so that should the layout or content change for some reason, the heading will always be at the top of
the page. Why does the layout alter like this? I wonder, therefore, if one of the selected options is causing it to
change. Is there an option that I should not select? I have also checked that the tab settings are the same, and
they appear to be. I have inherited these documents - they were created many years ago and have been added
to by various people over time. They were, I believe, originally created in WordPerfect before being converted
to Word I thought at first that the issues were due to different people formatting in different ways, but these
issues remain even when I fix the formatting. This thread is locked. You can follow the question or vote as
helpful, but you cannot reply to this thread.
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Chapter 7 : Converting Word pages to book pages, for novels? - Writing Stack Exchange
I may insert hard page breaks to do this, and I set margins accordingly, and save all the setting in the Word document.
However, when I try to print the same document from a different computer and printer a sentence or two of the text on
the first page wraps to a second page, and the rest of the second page is blank.

What Did I Change? Has this ever happened to you? Your idea is to send a Microsoft Word file back and forth
and you will each make changes. How will you maintain control of the project and keep track of your changes
vs. How can you keep track without any extra effort and free yourself to focus on your writing? Is there a way
to see the differences between them without spending hours comparing every word or sentence? You send
your Word document to someone else for review. Instead of sending you their notes separately, they make
their changes to the document and send their edited version back to you. What exactly did they change? You
write your notes and suggestions in a separate document or email. On the one hand this leaves the original
untouched, on the other hand every note has to specify the location or piece of text in the main document it is
referring to, and will become harder to understand the more the document evolves. You type your notes into
the document itself. In order to distinguish your notes from the original text, you might surround them with
square brackets [ ] , or use special formatting like ALL CAPITALS, a different font, bold or italic, or using a
vibrant text color like red or purple. This puts your notes in context, but it also makes the document longer,
changes the way the document looks and prints , and makes it harder to read. Also, all of these approaches
require you to document your changes or ideas, which is time-consuming, error-prone, and probably also
distracting from the writing process. Higher-tech approaches - A little more elegant It turns out that Microsoft
Word has some relatively simple high-tech features that can help in situations like this: Just as you can make
some of your text bold or red, you can also format text as "Hidden," making it useful for notes. Word has a
built-in function that lets you insert Comments into your document. A Comment has two parts: When you turn
this on, every change you make or someone else makes to your document is "tracked," including: Text added,
Text deleted, and Formatting changes font, size, bold, color, etc. Activating Track Changes in one document
does not affect any other documents. In some versions of Word it will probably also turn on the Reviewing
toolbar. Text you add will be underlined and in color. Text you delete will either become " strikethrough " or
be displayed as "deleted" in a "balloon" in the right margin. Formatting changes you make e. Vertical "change
bars" will also appear in the left margin next to any changed lines. You can also control whether Word uses
"balloons" in the right margin or in-line marks. Reviewing The Tracked Changes At any point you can
"review" the changes in your document. For each tracked change, you can: Inserted text and formatting
changes "settle in," and deleted text disappears. Inserted text and formatting changes disappear, and deleted
text returns. This leaves the tracked change as is. You can act on any tracked change individually and in any
order, or you can visit each tracked change in order going forward or backwards through the document.
Remember that they may have a different version of Word than you. You should also work out some other
issues: How will you send the document back and forth? I also recommend that you carefully name your
document based on where you are in the collaborative process, and expect to create a series of documents
during the project. For example, if "Joe" is your collaborator, instead of "Smith project. The other person may
not do this maliciously, they may simply not understand how to hide the visually distracting change-tracking
that will appear on-screen and when they print except by turning off Track Changes. The good news is that
Word has a Protect Document function that lets you among other things prevent Tracked Changes from being
turned off unless the correct password which you can set is entered. This also prevents anyone from accepting
or rejecting any of the tracked changes. Also, protecting a document does not encrypt it, so anyone who gets a
copy of the document has complete access to its contents. When you get the protected document back, if you
want to Accept or Reject any of the changes or turn off Track Changes , you will need to "Unprotect" it first
and enter the password. Open "B," the newer document that was modified by the other person. If you see the
"Compare and Merge Documents Locate and choose "A," the older, original document. You can also use this
method to compare two of your own documents to see how they differ. Other things you should know Tracked
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Changes is supported in. DOCX files, but not. Tracked Changes works with any number of collaborators.
Their changes will be tagged with the date and time they were made, and as long as each person makes their
changes using their own separate computer , their name. Word has another, more primitive function called
Versions, which lets you store multiple, complete versions of an entire document within the same file. If you
want to keep careful track of every change that you or someone else will make to your Word documents, try
Track Changes. You can Protect the tracking with a password if you need extra control. Where to go from here
Take Track Changes for a test drive: Create a new document and type in "This is my original document. Look
in the Help system for your version of Word for more detailed information on using these functions.
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Chapter 8 : Why doesnâ€™t the same Word document print the same from different printers?
I am trying to figure out why different paragraphs throughout a document look like a different font even though they are
formatted the same in font Cambria, size, color, etc. One font looks lighter and looser and the other darker and tighter.

File formats supported in Word Online Word Online opens documents in these formats: For example, these
formats are not supported: Top of Page Features supported for viewing and printing When you view or print a
document in Word Online, the document looks the same as it does in Print Layout view in the Word desktop
app. If you want Word features for printing such as adjusting page margins , click Open in Word, and print in
the Word desktop app. When you are viewing a document, some features work differently in the browser than
they do in the Word desktop app. To use features that are not available in Word Online, click Open in Word.
Likewise, the Navigation pane, side-by-side viewing, and split windows are not available in Word Online.
Rulers and gridlines Top of Page Features that differ between the browser and the desktop When you edit a
document in Word Online, the document is presented in Editing view so that you can edit and format text.
Additionally, many kinds of objects are displayed as placeholders. The following tables describe how Word
Online supports features that might apply to your documents. Click Open in Word to remove editing
restrictions. Manage Versions Versions are managed on the server rather than in Word Online. If your
document is stored in a SharePoint library, see if the Version History feature has been configured for the
library. Text is formatted to match the text surrounding where it is pasted in Word Online. Font formatting
Apply bold, italics, underline, strikethrough, subscript, superscript, font, size, color, and highlighting. You can
also clear font formatting. Paragraph formatting Align paragraphs left, right, or centered; run text right-to-left
or left-to-right; increase or decrease indentation; adjust line spacing; format paragraphs as a bulleted or
numbered list. You can also clear formatting. Numbering and bullets Apply one of several built-in numbering
or bullet styles. Styles Apply one of a gallery of built-in styles. You cannot create new styles or modify styles
in Word Online. Find Find is available only in Reading view. Find and Replace is not available in Word
Online. Zoom Zoom is available only in Reading view. Line breaks and page breaks Breaks between lines and
pages are displayed in Reading view. In Editing view, line breaks look the same as paragraph breaks, and page
breaks are not indicated. Co-authoring Multiple authors can work simultaneously in Word Online.
Co-authoring works across Word or later and Word for Mac Reviewing Works like this in Word Online
Proofing tools Check spelling and set the proofing language, using the built-in dictionary. Word Online does
not use a custom dictionary and does not include grammar checking, translation, or a thesaurus. Unlike the
Word desktop application, Word Online does not include a way to customize the AutoCorrect options.
Tracked changes Tracked changes appear in Reading view. To turn Track Changes on or off, click Open in
Word. Bookmark and cross-reference links work, and you can edit their display text, but not their destination,
in Word Online. Select by table, column, row or cell; delete by table, column, or row; Insert rows and
columns; align cell text left, right, or centered. More sophisticated table features--such as table styles, cell size,
text direction, and sort order--are preserved in the document, but cannot be configured in Word Online.
Pictures Insert pictures or clip art stored on your computer or from Bing. You can apply a number of picture
styles, write alt-text, and change the size, but pictures cannot be dragged to a new location. More sophisticated
features for working with pictures, such as cropping, are not available in Word Online. In Editing view they
appear as placeholders that you can delete but not edit. They cannot be moved or resized in Word Online.
Equations, symbols, ink These display in the document as expected in Reading view. Fields, content controls,
cover page These display in the document as expected in Reading view. In Editing view the content of fields
and content controls are displayed but cannot be edited or updated. A cover page appears as a series of
placeholders for elements like text boxes. Headers and footers These display in the document as expected in
Reading view. Headers and footers, including page numbers, are hidden in Editing view. Footnotes, endnotes,
bibliography, table of contents, index These display in the document as expected in Reading view. In Editing
view they appear as placeholders that you can delete but not edit or update. Macros You can view, edit, print,
and share documents that contain macros, but to run the macros click Open in Word. Linked pictures,
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Chapter 9 : Why Does My Microsoft Word Document Display Differently on Different Computers? - Ask Leo
If solving these problems are important to you, it's time to look into Word's Track Changes function! "Old-school"
approaches - Clumsy but simple Whether you're a teacher commenting on a student's paper, a professor commenting
on a thesis, an editor encouraging a writer to polish her prose, or a helpful friend lending a hand, collaborating with.
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